
APPENDIX E:  LEXICONS 
Page 

A. Overview ...................................................................................................................................... E:1 

What is a lexicon? ......................................................................................................................... E:1 

Why should I use a lexicon? ......................................................................................................... E:1 

How can I expand my data search capabilities by using a lexicon? ............................................ E:1 

What lexicons are included in ICMS? ........................................................................................... E:1 

Can I add additional lexicons to ICMS?........................................................................................ E:1 

B. Nomenclature 3.0 ........................................................................................................................ E:1 

What is Nomenclature 3.0? .......................................................................................................... E:1 

How do I use Nomenclature 3.0 lexicon in ICMS? ....................................................................... E:1 

Where do I go to find information on Nomenclature 3.0? ............................................................. E:2 

Can I add terms to Nomenclature 3.0? ......................................................................................... E:2 

C. NPS Classification Terms .......................................................................................................... E:2 

What are the NPS Classification Terms? ..................................................................................... E:2 

How do I use the NPS Classification Terms lexicon in ICMS?..................................................... E:2 

Where do I go to find information on the NPS Classification Terms? .......................................... E:2 

Can I add classification terms? ..................................................................................................... E:2 

D. HCO .............................................................................................................................................. E:3 

What is the HCO? ......................................................................................................................... E:3 

How do I use the HCO lexicon in ICMS? ...................................................................................... E:3 

Where do I go to find information on the HCO? ........................................................................... E:3 

Can I add classification terms to the HCO? .................................................................................. E:3 

E. ITIS ............................................................................................................................................... E:3 

What is ITIS? ................................................................................................................................ E:3 

How do I use ITIS in ICMS? ......................................................................................................... E:3 

Where do I go to find information on ITIS? ................................................................................... E:3 

Can I add classification terms to ITIS? ......................................................................................... E:3 

How do I update the ITIS table in ICMS? ..................................................................................... E:3 

F. AAT ............................................................................................................................................... E:5 

What is the AAT? .......................................................................................................................... E:5 

What is a thesaurus? .................................................................................................................... E:6 

What are AAT facets and hierarchies? ......................................................................................... E:6 

How do I use the AAT lexicon in ICMS?....................................................................................... E:6 

Where do I go to find information on the AAT? ............................................................................ E:7 

Can I add terms to the AAT? ........................................................................................................ E:7 

G. Browsing the Lexicons .............................................................................................................. E:7 

How do I access the browse lexicon feature in ICMS? ................................................................ E:7 

How do I browse a lexicon in ICMS? ............................................................................................ E:8 

H. Using Lexicons with Advanced Search .................................................................................. E:10 

How do I use lexicons with the Advanced Search function? ...................................................... E:10 

I. Creating a Park Lexicon ........................................................................................................... E:12 

What is a park lexicon?............................................................................................................... E:12 

Where do I go in the program to create a park lexicon? ............................................................ E:12 

How do I create a lexicon? ......................................................................................................... E:12 

How do I add a term to the park lexicon? ................................................................................... E:12 

How do I edit a park lexicon term? ............................................................................................. E:15 

How do I delete a park lexicon term? ......................................................................................... E:15 





ICMS User Manual (2015) E:1 Appendix E/Lexicons  

APPENDIX E:  LEXICONS 
 
A. Overview  

1. What is a lexicon? A lexicon is a standardized vocabulary or dictionary of terms.  It establishes 

relationships between words by placing them in categories within a 

hierarchy.  A lexicon allows you to select the most appropriate term.  It also 

allows you to move from that term to a broader, narrower, or related term. 

2. Why should I use a lexicon? Use a lexicon to: 

 

• act as an authority table  

 

• establish a relationship between words 

 

• expand your capability to search your database 

 

• maintain consistency in data entry 

3. How can I expand my data 
search capabilities by using 
a lexicon? 

Lexicons allow you to search by categories or by groups of terms rather than 

searching for each term individually.  For example, you can search for 

Building Materials, rather than individual types of building materials, such as 

brick, nail, or mortar. 

4. What lexicons are included 
in ICMS? 

ICMS includes several lexicons: 

 

• Nomenclature 3.0 for Museum Cataloging: Third edition of Robert G. 

Chenhall’s System for Classifying Man-Made Objects by Paul Bourcier, 

Ruby Rogers, and the Nomenclature Committee, AASLH Book Series, 

published by AltaMira Press, January 16, 2010. 

 

• NPS Classification Terms based on the NPS Museum Handbook, Part II, 

Museum Records (MH-II). 

 

• Hierarchical Classification Outline (HCO) from the MH-II. 

 

• Integrated Taxonomic Information System (ITIS) 

 

• Art & Architecture Thesaurus (AAT) published by Oxford University 

Press, 1994-2009, for The Getty Art History Information program. 

5. Can I add additional 
lexicons to ICMS? 

Yes.  You can add unit lexicons to ICMS.  Refer to Section I of this chapter 

for information on unit lexicons. 

B. Nomenclature 3.0  

1. What is Nomenclature 3.0? Nomenclature 3.0 is a system for classifying and naming historic material.  

The system is based on an object’s original function. 

2. How do I use Nomenclature 
3.0 lexicon in ICMS? 

You must use the Nomenclature 3.0 lexicon to classify and name history 

objects.  The classification categories and object terms appear in tables 

within ICMS.  Access the classification terms in Classification Lines 2, 3 

and 4.  Access the object terms from the Object field.  Refer to Section IV of 

Chapter 2 for information on cataloging history objects. 
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There is also a Revised Nomenclature field on the archeology specialty 

screen.  This field allows you to use the Nomenclature .3.0 lexicon with 

historic archeological material. 

 

 From any memo field in the program, you can access a list of 

Nomenclature 3.0 and AAT terms to use as vocabulary. 

  

Note:  To access the Nomenclature 3.0 object term table in a memo field, 

press F5 or right click and choose Browse Lexicon.  Once you are in the 

table, click Re:discovery Lexicon to see the term in the hierarchy.  

3. Where do I go to find 
information on 
Nomenclature 3.0? 

To learn how to use the Nomenclature 3.0 system for classifying and naming 

objects: 

 

• Read the opening chapters in the book.  Every site should have at least 

one copy of Nomenclature 3.0.  If you don’t have the book at your site, 

contact the Park Museum Management Program or your bureau’s 

museum property contact. 

 

• Refer to the NPS instructions for using the book in the MH-II, Appendix 

G. 

4. Can I add terms to 
Nomenclature 3.0? 

Yes.  Bureaus may add terms to Nomenclature 3.0.  Send requests for 

additional terms to your bureau’s museum property contact.  ICMS includes 

the most recent list of additional terms.  The Nomenclature 3.0 object list in 

ICMS will be periodically updated to include the new terms.  For the NPS, 

refer to the MH-II, Appendix G, for instructions on submitting object terms. 

 

Note:  You cannot add classification categories to Nomenclature 3.0. 

C. NPS Classification Terms  

1. What are the NPS 
Classification Terms? 

The NPS Classification Terms were chosen by various NPS discipline groups 

to use in classifying cultural resources collections.  The terms vary by 

discipline. 

2. How do I use the NPS 
Classification Terms lexicon 
in ICMS? 

You must use the NPS Classification Terms lexicon to classify cultural 

resources collections (archeology, archives, ethnology, history).  The 

classification categories appear in tables within ICMS for Classification 

Lines 1-4.  Refer to Sections I-IV of Chapter 2 for information on cataloging 

cultural resources collections. 

3. Where do I go to find 
information on the NPS 
Classification Terms? 

The following appendices in the MH-II contain information on the NPS 

Classification Terms: 

 

• Appendix D:  Archives and Manuscript Collections 

 

• Appendix E:  Archeology 

 

• Appendix F:  Ethnology 

 

• Appendix G:  History 

4. Can I add classification 
terms? 

No.  You cannot add classification terms or categories.  The classification 

tables are locked tables. 
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D. HCO  

1. What is the HCO? The HCO is a system for classifying natural history specimens.  The NPS  

developed the system in collaboration with discipline-specific specialists in 

NPS and other institutions. 

2. How do I use the HCO 
lexicon in ICMS? 

You must use the HCO in ICMS to classify geology specimens in the 

Natural History directory.  The classification categories appear in tables 

within ICMS for Classification Lines 1-4 for geology.  Refer to Section VI 

of Chapter 2 for information on cataloging geology collections. 

 

Note:  Biology and paleontology specimens now use the ITIS system to 

complete the classification.  Refer to Sections V and VII of Chapter 2. 

3. Where do I go to find 
information on the HCO? 

The HCO is part of the MH-II, Appendix H:  Natural History.  The appendix 

includes an explanation of how to use the HCO. 

4. Can I add classification 
terms to the HCO? 

No.  You cannot add terms to the HCO. 

E. ITIS  

1. What is ITIS? The Integrated Taxonomic Information System (ITIS) is a partnership of 

U.S., Canadian, and Mexican agencies (ITIS-North America); other 

organizations; and taxonomic specialists.  ITIS is also a partner of Species 

2000 and the Global Biodiversity Information Facility (GBIF).  It is an online 

database that includes authoritative taxonomic information on plants, 

animals, fungi, and microbes of North America and the world. 

2. How do I use ITIS in ICMS? You can use ITIS in ICMS to complete the classification fields for biology 

and paleontology specimens in the Natural History directory.  The ITIS 

database is accessed through the Find Specimen link when adding, copying 

or modifying a biology or paleontology record.  Refer to Sections V and VII 

of Chapter 2 for information on cataloging biology and paleontology 

specimens. 

 You are not required to use ITIS to complete the classification fields.  You 

can enter classification information individually if the specimen you are 

cataloging does not exist in the ITIS database. 

 
3. Where do I go to find 

information on ITIS? 

 

Information about ITIS can be found on their web site.  Using Internet 

Explorer, go to http://www.itis.gov. 

4. Can I add classification 
terms to ITIS? 

No.  You cannot add terms to ITIS.  ITIS continually updates their database 

with new information.  Updates to the ITIS database will be available in 

ICMS through the ITIS Tables Update option on the Tools menu (see E.5 

below).   

 

Additional terms from paleontology collections that do not appear in the ITIS 

database have been added to the ICMS copy of the database. 

5. How do I update the ITIS 
table in ICMS? 

You must be connected to the internet to download the ITIS update files.  To 

update the ITIS table in ICMS: 

 

• Go to the Tools menu and select ITIS tables Update 
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Note:  If the ITIS update zip file was provided to you with an upgrade or you 

downloaded it from the Rediscovery ftp site at 

ftp://ftp.rediscov.com/ICMS/ITIS, skip to the Unzip and Install tab 

instructions below. 

 

• Click Check for Updates to determine if you have the latest version of 

the ITIS tables. 

 

• If the response indicates that there is an update available for your 

system, click on the Download ITIS tab. 

 

 
 

• Enter a location to save the download file on your computer.  You can 

also click the Browse link to select a folder. 

 

• Click the Download link to begin the download. 

 

• When the download is complete, click on the Unzip and Install tab. 
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• Check that the full path to the zipped ITIS file is correct, or click the 

Browse link to locate the ItisTables.zip file. 

 

• To install the ITIS update, click Update Re:discovery ITIS tables.  The 

processing steps will be displayed. 

 

 
 

• When the update has completed, click the X to close the window. 

F. AAT  

1. What is the AAT? The Art & Architecture Thesaurus (AAT) provides a standardized vocabulary 

for fine arts, architecture, decorative art, and material culture of the Western 

world. The AAT is an evolving indexing language that is open to user 

suggestions.  It is: 

 

• constructed as a list of single concepts 

 

• arranged within facets (see F.3. below) 

 

• displayed hierarchically and alphabetically 

 

• designed for indexing and retrieving 

 

 

The AAT isn't a classification system, data structure standard, or cataloging 
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system.  It doesn't contain personal, corporate, building, institutional, or 

geographic names or historic events.    

2. What is a thesaurus? The AAT defines a thesaurus as "the controlled vocabulary of an indexing 

system, arranged in a known order and structured so that synonymous, 

hierarchical, and associative relationships among terms are clearly displayed 

and identified by standardized relationship indicators."  

 

A well constructed thesaurus: 

 

• establishes a preferred form of a term 

 

• links synonyms and spelling variants 

 

• provides consistency for information retrieval 

 

• provides authority for usage of the term 

 

• uses classification principles to structure terminology 

3. What are AAT facets and 
hierarchies? 

There are 8 facets and 35 hierarchies in the AAT:  

 

• A facet is a homogeneous class of concepts.  Members within a facet 

share characteristics that distinguish them from the members of other 

classes.   

 

Example: Marble falls within the Materials facet.  Impressionist falls 

within the Styles and Periods facet. 

 

• A hierarchy is a homogeneous grouping of terminologies arranged 

within the 8 facets.  Hierarchies display relationships between terms. 

 

Example: Relief prints include woodcuts, relief etchings and wood 

engravings. 

4. How do I use the AAT 
lexicon in ICMS? 

You can use the AAT in several ways in ICMS: 

 

• On the history record, use the Term AAT field to record a term for the 

object.  Refer to Section IV of Chapter 2 for information on cataloging 

history objects. 

 

• From any memo field in the program, you can access a list of AAT and 

Nomenclature 3.0 terms to use as vocabulary. 

 

• Use the AAT in a word search to extend the search to include related 

words in the lexicon.  Refer to Section H below. 

 

Note:  To access the AAT in a memo field, press F5 or right click and choose 

Browse Lexicon.  Once you are in the table, click Re:discovery Lexicon to 

see the term in the hierarchy.  

 You are not required to use the AAT. 
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5. Where do I go to find 
information on the AAT? 

To learn how to use the AAT: 

 

• Purchase or borrow the printed edition of the AAT.  The Bureau does not 

supply the AAT to units.  Use of the AAT is optional. 

 

• Take a training course on how to use the AAT.  Contact the Getty Art 

History Information Program for information on training courses. 

 

For information on the AAT, contact:   

 

The Getty Information Institute 

1200 Getty Center Drive 

Suite 300 

Los Angeles, CA  90049-1680 

310-440-6379 

6. Can I add terms to the AAT? No. You cannot add terms to the AAT lexicon within ICMS.  However, you 

can submit terms to the Getty Art History Information Program for 

consideration.  Re:discovery Software, Inc. will periodically update the AAT 

lexicon in ICMS as updates are released from the AAT. 

G. Browsing the Lexicons  

1. How do I access the browse 
lexicon feature in ICMS? 

You can access the browse lexicon feature from any record.  To access the 

browse lexicon screen: 

 

• Click the Lexicon button  on the button bar 

 

• Under Go To on the View menu from most places in the software, 

choose Lexicon. 

 

• From a field using the lexicon as the authority table, press F5 or right 

click and choose Zoom.  Then click Re:discovery Lexicon.  Note:  If the 

field is a stacked authority field, you will have to expand it first by 

pressing F5 or F12 and then press F5 in the single lexicon entry line. 

 

• When in Add, Copy or Modify mode, right-click in a memo field and 

choose Browse Lexicon.   Then click Re:discovery Lexicon. 
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 The Lexicon window consists of 3 panes just like the main system screen.  

These panes are resizable using click-and-drag to resize them. 

 

• The Navigation Pane on the left shows you the lexicon in a tree view and 

lets you navigate terms using the hierarchy. 

 

• The Record Pane on the bottom right shows you the currently selected 

term record.  The Term tab contains information about the classification 

of the term while the Relationships tab contains related terms (Broader, 

Narrower, Use For and Equivalent, Alternate, Related, UK, and UK 

Alternate). 

 

• The List Pane on the upper right displays the selected term’s most 

immediate relationships as entered on the Relationships tab in the term’s 

record.  Just like in the List Pane of the main system, you can click on 

the column headers to resort and filter the related terms. 

 

Simply double-click a term in the Navigation Pane to load it into the Record 

Pane, see its relationships in the List Pane, and to expand it in the Navigation 

Pane to display its sub-terms. 

2. How do I browse a lexicon 
in ICMS? 

There are several ways to navigate the hierarchical lexicon. 

 

• You can use the Term Lookup just above the Navigation Pane. 

 

• You can use the Tree in the Navigation Pane to find a term. 

 

• You can use the List Pane to load a term by simply double-clicking on 

the term. 

 

• You can use the Breadcrumb at the top of the window just below the 

button bar.  Click on any term in the breadcrumb to load that term. 

From Term Lookup If you know what term you want to view but do not know what lexicon(s) it 

is in or where it falls in the hierarchy, you can go directly to it using the 

Term Lookup field. 

 

• Click the  icon in the Term Lookup field, press [F5], or start typing 

the term and the Term Selector window will open showing the list of 

lexicon terms. 

 

 

 Note:  As you type in the Search field, the list will take you to the term.  The 

description column indicates in which lexicon(s) the term is found. 
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• When you find the term you want, click Select.  That term will load into 

the Record Pane, its related terms will display in the List Pane, and the 

Navigation Pane will show where it falls in the hierarchy. 

 

 

From the Navigation Pane You can use the tree in the Navigation Pane to navigate through the hierarchy 

to find a term.  Simply double-click a term in the Navigation Pane to load it 

into the Record Pane, see its relationships in the List Pane, and to expand it 

in the Navigation Pane to display its sub-terms. 

 

• Choose the lexicon you want to navigate through using the pull down 

menu in the Lexicon field.  Your choices are: 

 

 AAT 

 HCO 

 Nomenclature 3.0 

 NPS Classes 

 NPS Rev Nom 

 Park Lexicon 

 

• The tree in the Navigation Pane will refresh to show you the most 

immediate narrower terms of the nomenclature selected. 
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 • Double-click on the next term you want to expand to see its most 

immediate narrower terms.  

 

Example: Double-click COMMUNICATION ARTIFACTS.  It will 

load that term into the Record Pane, show its related terms in 

the List Pane, and display its location in the hierarchy in the 

navigation tree. 

 

• Keep double-clicking terms in the tree until you get to the desired term.  

(You can also use the Expand Tree and Collapse Tree links to open or 

close the different levels.) 

 

Note:  At the bottom of the Navigation Pane, click Select Previously 

Viewed Term to load the term you were just looking at in the Record Pane. 

From the List Pane As you navigate around in the lexicon, you can load any term you see in the 

List Pane by simply double-clicking it.  It will become the selected term and 

will load that term into the Record Pane, show its related terms in the List 

Pane, and display its location in the hierarchy in the navigation tree. 

Breadcrumb At the top of the screen, below the button bar, is a Breadcrumb showing you 

the trail of the direct path down the hierarchical lexicon from the topmost 

parent term to the currently selected term. 

 

 

 You can click on any term in the Breadcrumb to load that term into the 

Record Pane. 

H. Using Lexicons with 
Advanced Search 

 

1. How do I use lexicons with 
the Advanced Search 
function? 

You can use the lexicons within the program to specify terms that you want 

to add to a search.  Using terms within the lexicon, you can extend your 

search to associated, narrow, broader, related and sibling terms. 

 

To extend an Advanced Search using a lexicon: 

 

• In the Advanced Search window, enter a term in the search box. 
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 • Check the appropriate box on the right under Lexicon Options to extend 

a search.  By clicking on the box, you can add or remove a check mark 

to designate the terms to include.  You can also click Reset to Default to 

clear all checked boxes.  The lexicon options are: 

 

Proper Term – will look for the word you enter, plus the proper 

usage of the word. For example, if you search for 

IMPRESSIONISM, Advanced Search will also look for 

IMPRESSIONIST. 

 

Associated Terms – will look for the term you enter, plus any 

terms associated with it, according to the lexicon. 

 

Narrower Terms – will look for the term you entered, plus 

narrower terms as defined by the lexicon.  If you enter SHOE, 

search will also look for MUKLUK. 

 

Broader Terms – will look for the term you entered, plus broader 

terms as defined by the lexicon. 

 

Related Terms – will look for the term you entered, plus Related 

terms as defined by the lexicon.  For example, if you enter MUGS, 

search will also look for CUPS. 

 

Note:  If you do not see the Lexicon Options tab, check the More Options 

box on the lower left of the Advanced Search window. 

 • If you would like to see the terms that will be searched, click Show 

lexicon terms to search and the list will populate with the terms from the 

lexicon that are linked to the term you entered according to the lexicon 

option(s) you chose. 

 

Note:  If you do not want to search all the terms listed, you can check terms 

in this list that you want to exclude from the search. 

 During the word search, you will see the various lexicon terms flash on the 

screen.  The search results will include the keyword(s) and the other lexicon 

terms you selected.  When the search is complete, the lexicon terms that were 

searched will appear in the Related Words Searched For box on the Search 

Results tab. 
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 Refer to Section I of Chapter 7 for information on how to conduct a word 

search. 

I. Creating a Park Lexicon  

1. What is a park lexicon? A park lexicon is a vocabulary of terms and relationships that you develop 

from the specific material at your site.  For example, you may want to 

associate specific names or objects as narrower terms under various broad 

terms.  You can then do one search to find all the records that contain 

information on objects or people associated with the terms. 

2. Where do I go in the 
program to create a park 
lexicon? 

To create a park lexicon you must go to the Re:discovery Lexicon screen.  To 

access the screen: 

 

• Click the Lexicon button  on the button bar, or 

 

• Under Go To on the View menu from most places in the software, 

choose Lexicon. 

 

The Re:discovery Lexicon window will open. 

 

Note:  You don’t need special security access to create a park lexicon. 

3. How do I create a lexicon? Creating lexicons requires a lot of time and effort.  You must precisely define 

the terms you want to use.  You must also precisely define how the terms fit 

within a hierarchy of broader, narrower, and synonymous terms. 

 

Before creating a park lexicon, it’s a good idea to talk to other sites that have 

created lexicons.  Contact Re:discovery Software, Inc. at 434-975-3256 for 

the names of sites or other museums that have created their own lexicons. 

4. How do I add a term to the 
park lexicon? 

To add a term to the park lexicon: 

 

• Choose Park Lexicon from the Lexicon pull down in the upper left. 

• Click the Add button  on the button bar, press [F9], or select Add 

New Term on the Edit menu. 

 

• The Record Pane will open a new record ready for you to fill in and Add 

Mode appears in the lower right of the Status Bar. 
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 • Fill in the classification information on the Term tab. 

 

Term:  Enter the new term.  This is a required field.  

 

Lexicon(s):  The lexicons this term is a part of.  PRK will 

automatically be entered.  You cannot edit the field. 

 

Classification:  Enter PRK if this is a preferred term in the lexicon.  

If this field is blank, the term is not considered a preferred term by the 

system.  Entering non-preferred terms in the lexicon can be a useful 

way to point non-preferred terms to preferred terms.  When viewing 

the relationships in the Navigation Pane, preferred terms are displayed 

with Preferred Term next to them if they are related to a non-

preferred term (Classification is empty).  

 Department:  Large Institutions may want to indicate which 

department (archives, historical, art, etc.) entered the term.  This is a 

user built authority field. 

 

Language:  Institutions managing multi-cultural collections may 

want to indicate the language of origin for the term. 

 

Approved:  Used to indicate whether the term is a generally approved 

term. It is not used by the system to determine whether a term is 

accepted or not in the formal lexicon.  This approval field is for client 

reference only.  For example, a user may enter terms that may need to 

be approved for use by a supervisor. 

 Scope Note:  This is an optional field containing an instructional 

statement that defines or clarifies the usage or meaning of the concept 

and how it fits into the context of the nomenclature.  

 

See Reference:  This is an optional field, used to indicate references 

for the derivation for the term and its usage. 

 

See Also:  This is an optional field to list other terms that are similar, 

but not necessarily approved terms. 

 

Note:  This is an optional field to be used however the institution sees 

fit. 
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 • To create relationships between this term and other terms in the lexicon, 

click on the Relationships for Lexicon PRK tab. 

 

Note:  The definitions that follow are general ones to help users begin to 

understand a Lexicon's structure. For additional information on Lexicons, 

users should refer to the Getty Information Institute's AAT website at 

http://www.getty.edu/research/conducting_research/vocabularies/.   Also, the 

introduction to Nomenclature 3.0 for Museum Cataloging: Third edition of 

Robert G. Chenhall’s System for Classifying Man-Made Objects has 

information on Nomenclature 3.0. 

 

 

 Broader Terms:  Broader terms include the "super group(s)" to 

which a term belongs.  It is also known as the “parent term”.  Nail 

might have a broader term of WOODWORKING T&E.  This is a 

required field.  If you do not enter a broader term, the system will fill 

in ‘Unassigned’ as the broader term.  You must associate the new 

term with a Broader Term, even if it is just the top level ‘Park 

Lexicon’ term. 

 

Narrower Terms:  This relationship relates to subordinate terms. It is 

also known as the “child” term.  If WOODWORKING T&E is a 

broader term of NAIL, then NAIL is a narrower term of 

WOODWORKING T&E. 

 

Use For and Equivalent:  When several formats of a term refer to 

the same concept, but there is a preferred and non-preferred format, 

they are equivalent.  These are usually terms that appear in different 

languages or formats. The preferred format is indicated by a 

designator in the Classification field and has [Use Instead] following 

the term.  The non-preferred form is followed by [Use For].  For 

example, “Concrete Art” is the preferred term and should be used in 

place of “art, Concrete”, “Art Concret”, and “Konkrete Kunst”. 

 Alternate:  This will indicate valid forms of the term that may be 

used in place of the selected term. An alternate term is usually a 

singular form or a different part of speech (adjective or possessive).  

For example, Impressionism is an alternate term for Impressionist, but 

Impressionist is the preferred term. The Classification field for 

Impressionist indicates the lexicon where it is accepted. 
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Related:  Related terms are similar concepts but not identical terms. 

Both can be considered preferred object terms rather than being 

related through hierarchical or equivalence relationships.   

 

UK:  This will indicate a variation in spelling of the term recognized 

in the United Kingdom.  Color could have a UK relationship to 

colour.  

 

UK Alternate:  This will indicate a valid form of the term in the 

United Kingdom that may be used in place of the selected term such 

as shoppe for shop. 

 

The Relationship fields are stacked lexicon lookup fields so you can 

select more than one term of the same type of relationship. 

 • Save the new term using one of the Save Options 

 

Save and Close:  Use to save the new term and close the Lexicon. 

 

Save and Add Another:  Use to save the new term and immediately 

bring up a new window in Add mode. 

 

Save:  Use to save the new term and keep the Lexicon window open. 

 

Note:  If the term is already part of another lexicon, you will receive a 

message indicating that the term already exists.  To add the term to your park 

lexicon to set up additional relationships,  you must use the Add Existing 

Term to Lexicon option on the Edit menu, or click the  button on the 

button bar.  The term field will then allow you to choose the term from a 

lexicon term selector window.  You will only be able to edit the Note field 

and add relationships on the Relationships for Lexicon PRK tab.  All other 

fields will be locked. 

5. How do I edit a park lexicon 
term? 

You cannot edit terms in locked lexicons such as the AAT and Nomenclature 

3.0, but you can edit terms in the Park Lexicon.  You will be warned if you 

cannot modify the term because it is part of a locked lexicon.  To edit a term: 

 

• Select the term in the Park Lexicon you want to edit. 

 

• Click the Modify button on the button bar, press F10, or select Modify 

This Term on the Edit menu. 

 

• The Record Pane will open the current term ready for modification and 

Modify Mode appears in the lower right of the Status Bar. 

 

• Make any necessary changes to the term and its relationships. 

 

• Click Save and Close to save the term.  

6. How do I delete a park 
lexicon term? 

You cannot delete a term from a locked lexicon such as AAT and 

Nomenclature 3.0.  You will be warned if you cannot delete the term because 

it is part of a locked lexicon.   

 

• Select the term you want to delete. 

 

• Select Delete This Term from the Edit menu. 
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If the term has relationships set up with other terms, a warning message will 

indicate that there are other terms related to the term you are deleting.  

Deleting the term will permanently remove all relationships to other terms in 

the lexicon. 

 

Note:  If the term is part of a locked lexicon and you want to remove it from 

the park lexicon, select Remove This Term From Lexicon from the Edit 

menu. 

 


